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GroupWise 8

November 17, 2008

1  Overview
The main emphasis of Novell® GroupWise® 8 is the enhancement of the various GroupWise client 
interfaces and functionality. Administration and agent enhancement are also included.

Windows Client Enhancements: The Windows* client now lets you choose either 
OpenOffice.org* or Microsoft* Word as your editor when composing messages, and provides 
Auto-Save protection against message loss. Panels can be configured to display Web pages and 
RSS feeds. Improved Calendar features include accepting items into any calendar, publishing 
personal GroupWise calendars and free/busy schedules on the Web, subscribing to calendars on 
the Web, and checking the free/busy schedules for Internet users. Improved Contact features 
include business card format, a contacts index with lettered tabs, multiple Contacts folders, and 
contact photos. Improved Tasklist features include subtasks, percent complete, date complete, 
and task sorting. 
Linux/Mac Enhancements: The Linux*/Mac* client has added many features, including the 
Home Folder, the Nav Bar, more flexible panels, toolbar customization, categories, improved 
Find capabilities, item personalization, item type modification, multiple calendars, calendar 
selection for appointment acceptance, shared calendars, updated calendar views, import/export 
calendars, additional forms for calendar printing, date/time format modification, CASA login 
support, Auto-Save protection against message loss, external accounts (POP, IMAP, and 
NNTP), and Notify. 
WebAccess Client Enhancements: The WebAccess client now provides a scrollable message 
list, auto-save protection against message loss, name completion, HTML Compose mode, 
improved spell checking, and categories. Calendar enhancements include a graphical Calendar 
with multiple-calendar support, drag-and-drop appointments, publishing personal GroupWise 
calendars and free/busy schedules on the Web, calendar colors, and automatic time zone 
synchronization with your workstation. Contact Management now includes a contact summary, 
e-mail history, and notes. Keyboard shortcuts such as Ctrl+A to select all items and Del to 
delete items make the new message list very easy to use.
Administration Enhancements: GroupWise administrators benefit from a new GroupWise 
Installation program that streamlines creation of a basic GroupWise system (administration, 
domain, post office, and agents) and that provides for saving installation options so that 
installations can be repeated without interaction. The GroupWise snap-ins to ConsoleOne® 
have been improved to provide more currently appropriate agent settings defaults, more 
efficient addressing for external Internet domains, a significantly larger maximum mailbox 
size, the ability to set the default MIME encoding character set, and the ability to customize the 
Training and Tutorials URL. The options file for GroupWise Check now uses the same XML 
format across NetWare®, Linux, and Windows so that the same options file can be used on any 
platform.
Agent Enhancements: The new Calendar Publishing Host and the enhanced POA provide 
support for the calendar publishing features in the Windows and WebAccess clients. The new 
Document Conversion Agent and the enhanced POA provide indexing of additional document 
formats such as PDF, OpenOffice.org, and Microsoft Office 2007. The POA also has enhanced 
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performance when auto-archiving and emptying large numbers of items. The Internet Agent 
provides more flexibility for blocking rule-generated messages, e-mail notifications for 
messages that are delayed before being sent out across the Internet, and more complete status 
and configuration information on the Internet Agent Web console.

2  GroupWise System Requirements
GroupWise 8 system requirements are listed in the GroupWise 8 Installation Guide (http://
www.novell.com/documentation/gw8).

IMPORTANT: GroupWise system requirements do not apply to GroupWise Mobile Server. For 
GroupWise Mobile Server requirements, see the GroupWise Mobile Server Readme (http://
www.novell.com/documentation/groupwise_mobile_3).

3  NetWare/Windows Installation
Section 3.1, “NetWare/Windows Administration Software Installation Instructions,” on page 2
Section 3.2, “Windows Client Software Installation Instructions,” on page 3

3.1  NetWare/Windows Administration Software Installation 
Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 8 
Interoperability Guide (http://www.novell.com/documentation/gw8) for cluster-specific installation 
instructions before starting to install the GroupWise 8 software.

To install GroupWise 8 on NetWare or Windows:

1 Select an appropriate location to run the GroupWise Installation program.

2 If you are setting up your basic GroupWise system on NetWare, map a drive to the NetWare 
server where you want to create your initial domain and post office and to install the 
GroupWise agents. 

3 Log in as an Admin equivalent to the eDirectoryTM tree in which you are creating your 
GroupWise system.

4 Insert the GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe at the root of the downloaded GroupWise 8 image.

NetWare: If you are setting up your basic GroupWise system on NetWare, you can run the 
Installation program from any Windows machine that meets the administrator 
machine requirements.

Windows: If you are setting up your basic GroupWise system on Windows, you must run the 
Installation program at the Windows server were you want to create your initial 
domain and post office and install the Windows agents. It must also meet the 
administrator machine requirements as well as the server operating system 
requirements.
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The GroupWise Installation program lets you view the Readme, the Administrator Quick Start, 
and the Installation Guide before you start installing GroupWise.

5 Select the language in which you want to run the GroupWise Installation program, then click 
OK.
All available languages are included on the GroupWise 8 DVD and the multilanguage version 
of the downloaded GroupWise 8 image, but you can select which languages you want to install.

6 Click Install GroupWise System, click Yes to accept the License Agreement, then click Next to 
begin a standard installation.
The Create a New System option is selected by default.

7 Click Next, then follow the on-screen instructions to set up your basic GroupWise system.

For detailed system installation and update instructions, and a complete list of new features, see the 
GroupWise 8 Installation Guide (http://www.novell.com/documentation/gw8).

3.2  Windows Client Software Installation Instructions
1 At a Windows workstation that meets the GroupWise client system requirements, insert the 

GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run setup.exe from the root of the downloaded GroupWise 8 image.

2 Select the language in which you want to run the GroupWise Installation program, then click 
OK.
All available languages are included on the GroupWise 8 DVD and the multilanguage version 
of the downloaded GroupWise 8 image, but you can select which languages you want to install.

3 Click Install More Components > Install GroupWise Client to start the client Setup program.
4 Select the language in which you want to run the client Setup program, then click OK.
5 Follow the on-screen instructions to install the GroupWise 8 client software on your 

workstation.

4  Linux Installation
Section 4.1, “Linux Administration Software Installation Instructions,” on page 3
Section 4.2, “Linux Client Software Installation Instructions,” on page 4
Section 4.3, “Mac Client Software Installation Instructions,” on page 4

4.1  Linux Administration Software Installation Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 8 
Interoperability Guide (http://www.novell.com/documentation/gw8) for cluster-specific installation 
instructions before starting to install the GroupWise 8 software.

1 Make sure that ConsoleOne is installed on your Linux server.
2 At a Linux server that meets the administrator machine requirements, insert the GroupWise 8 

DVD. 
or
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Run ./install at the root of the downloaded GroupWise 8 image.
3 Specify the root password, then click OK.
4 Select the language in which you want to run the GroupWise Installation program, then click 

OK.
The GroupWise Installation program lets you view the Readme, the Administrator Quick Start, 
and the Installation Guide before you start installing GroupWise.
On Linux, all available languages are included in the GroupWise RPMs, so all languages are 
always installed.

5 Click Create or Update a GroupWise System.
6 Follow the on-screen instructions to install the GroupWise 8 software.

For detailed system installation and update instructions, and a complete list of new features, see the 
GroupWise 8 Installation Guide (http://www.novell.com/documentation/gw8).

4.2  Linux Client Software Installation Instructions
1 At a Linux workstation that meets the GroupWise client system requirements, insert the 

GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program.
or
Run ./install from the root of the downloaded GroupWise 8 image.

2 Specify the root password, then click OK.
3 Select the language you want, then click OK.
4 Click Install Products > Install GroupWise Client.
5 To start the Linux client after installation, click the GroupWise icon on your Linux desktop.

4.3  Mac Client Software Installation Instructions
1 At a Macintosh* workstation that meets the GroupWise client system requirements, insert the 

GroupWise 8 DVD into the DVD drive to start the GroupWise Installation program, double-
click the CDROM icon that appears on your desktop, double-click the mac folder, then double-
click the GroupWise .dmg file to create the GroupWise package.
or
Double-click the downloaded GroupWise .dmg file to create the GroupWise package.

2 Drag the GroupWise package from the DVD to the Applications folder to install the 
software on your Mac.

3 Drag the GroupWise package from the Applications folder to the Mac dock to create a 
GroupWise icon for convenient access.

4 Click the GroupWise Mac client icon on the dock to start the Mac client.

5  Installation Issues
Section 5.1, “General Installation Issues,” on page 5
Section 5.2, “NetWare/Windows Installation Issues,” on page 6
Section 5.3, “Linux Installation Issues,” on page 7
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Installation issues for individual GroupWise components are located under the heading for each 
component.

5.1  General Installation Issues
“GroupWise Version Compatibility” on page 5
“GroupWise Views Compatibility” on page 5
“Domain Services for Windows Compatibility” on page 6
“WebAccess and Monitor on the Same Web Server” on page 6
“SOAP Client Connection Issue during Post Office Updates” on page 6
“Additional Installation Issues” on page 6

5.1.1  GroupWise Version Compatibility

If you install GroupWise on multiple platforms, or if you run multiple versions (for example, 
GroupWise 6.5 or 7 and GroupWise 8 in the same GroupWise system), refer to the GroupWise 
Version Compatibility section in the GroupWise 8 Installation Guide (http://www.novell.com/
documentation/gw8) to make sure that the combinations you are using are supported. 

For example, you cannot run a GroupWise 8 client against a GroupWise 7 or earlier post office. 
Earlier POAs cannot support later GroupWise clients. However, you can run a GroupWise 7 or 
earlier client against a GroupWise 8 POA.

Also, you cannot run the GroupWise 7 or earlier snap-ins to ConsoleOne to access GroupWise 8 
databases or eDirectory objects. You can use Admin Lockout Settings under Tools > GroupWise 
System Operations > System Preferences to specify the required version of the ConsoleOne snap-ins 
for each domain as needed.

See also Section 9.1.1, “GroupWise 8 WebAccess Compatibility with Earlier Versions of 
WebAccess,” on page 19.

5.1.2  GroupWise Views Compatibility

When you create a GroupWise 8 post office, the GroupWise 8 client view files are installed. If an 
earlier GroupWise client tries to access the GroupWise 8 post office, some of the view files required 
by earlier GroupWise clients are not present. If possible, update all users in the post office to the 
GroupWise 8 client.

If you need to run earlier GroupWise clients on a new GroupWise 8 post office, you must copy the 
missing client view files from a post office where they are available. Client view files are stored in 
the following directory for all platforms:

post_office\ofviews\win

Be sure to copy only the missing files. Some GroupWise 8 view files are new. Some GroupWise 
view files have had the language code us changed to en in GroupWise 8. Some GroupWise 8 view 
files have the same names as earlier versions. Do not overwrite GroupWise 8 view files with earlier 
versions that have the same names.
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5.1.3  Domain Services for Windows Compatibility

GroupWise 8 cannot be installed in a Domain Services for Windows (DSfW) partition. However, it 
can be installed in eDirectory tree that has a DSfW partition, as long as you do not try to create 
GroupWise objects in the DSfW partition.

5.1.4  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a common 
library. If you are updating from an earlier GroupWise version and if you run these applications on 
the same Web server, you must update all three before any of them can work properly.

5.1.5  SOAP Client Connection Issue during Post Office Updates

For a large post office, a period of time can pass between when the POA starts updating the post 
office and when it finishes the update. During this period, programs that connect to POAs by using 
SOAP (such as SOAP e-mail clients, GroupWise Mobile Server, and BlackBerry* Enterprise 
Server) might receive the following error:

53336 - Incompatible Post Office version detected during login

This error should disappear when the post office update is complete. You can tell that the update is 
complete in ConsoleOne by checking the Database Version field on the Identification page of the 
Post Office object. If the update seems complete but the Database Version field has not updated to 
8.0, restart the POA.

5.1.6  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

5.2  NetWare/Windows Installation Issues
“System Creation on Windows Server 2008 and Vista” on page 6
“ConsoleOne on Windows Server 2008 and Vista” on page 6
“New Default Installation Paths on Windows” on page 6
“Problem Installing from a Windows XP Service Pack 2 Machine” on page 7

5.2.1  System Creation on Windows Server 2008 and Vista

You cannot create a new GroupWise system when running the GroupWise Installation program on 
Windows Server* 2008 or Windows Vista*. However, installation of individual software 
components can be performed on these operating systems.

5.2.2  ConsoleOne on Windows Server 2008 and Vista

You cannot currently run ConsoleOne on Windows Server 2008 or Windows Vista.

5.2.3  New Default Installation Paths on Windows

On Windows workstations and servers, the default GroupWise software locations have been 
consolidated under c:\Program Files\Novell into the following subdirectories:
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If you update existing software with GroupWise 8 software, the default location is the existing 
location. If you install GroupWise 8 software on a new machine, the default location is as listed 
above. In either case, you can override the default and specify a different location.

5.2.4  Problem Installing from a Windows XP Service Pack 2 Machine

When installing any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet Agent, 
WebAccess Agent, Monitor Agent) to a NetWare server from a Windows XP machine where 
Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later installed on 
the Windows machine. If you have an earlier Novell Client, the GroupWise Installation program 
claims that it cannot find some of the directories to which you want to install software.

5.3  Linux Installation Issues
“GroupWise Installation to a Xen Guest on SUSE Linux Enterprise Server 10” on page 7
“Upgrading from an Incomplete Software Distribution Directory” on page 8

5.3.1  GroupWise Installation to a Xen Guest on SUSE Linux Enterprise Server 10

When you install GroupWise on SUSE® Linux Enterprise Server (SLES) 10 to a Xen* guest, you 
might receive the following error message:

The current window is not large enough to run install. Please resize the window and 
run install again.

At present, the SLES 10 Xen console window does not report its dimensions properly. To work 
around this:

1 Make sure that SSH is enabled on the Xen guest.
2 Open an X terminal window on the SLES 10 Xen host, using the following command:

ssh -X root@guest_ip_address

3 Run the GroupWise Installation program from the Xen host.

GroupWise 
Component

Previous Default 
Location Current Default Location

Client c:\novell\groupwise c:\Program Files\Novell\GroupWise

Agents c:\grpwise c:\Program Files\Novell\GroupWise Server\Agents

Internet 
Agent

c:\grpwise\gwia c:\Program Files\Novell\GroupWise Server\GWIA

WebAccess 
Agent

c:\webacc c:\Program Files\Novell\GroupWise Server
\WebAccess

Monitor 
Agent

c:\gwmon c:\Program Files\Novell\GroupWise Server\Monitor
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5.3.2  Upgrading from an Incomplete Software Distribution Directory

All GroupWise components on a server must be updated at the same time. Therefore, if you are 
installing GroupWise 8 from a software distribution directory that does not contain RPMs for all the 
components installed on the server, you receive the following error:

Install failed for an unknown reason (7)

The GroupWise 8 component cannot be updated because its RPM is not present in the software 
distribution directory. You can use the GroupWise 8 for Linux downloaded image to update the 
server, then use Install Products > GroupWise Administration > Configure Administration in the 
GroupWise Installation program to create a complete software distribution directory.

6  Administration Issues
Section 6.1, “General Administration Issues,” on page 8
Section 6.2, “NetWare/Windows Administration Issues,” on page 10
Section 6.3, “Linux Administration Issues,” on page 10

6.1  General Administration Issues
“Obsolete Admin-Defined Fields” on page 8
“Server Names” on page 9
“Identity Manager Version Compatibility” on page 9
“Identity Manager Configuration Issue” on page 9
“Server-Based Anti-Virus Software” on page 9

6.1.1  Obsolete Admin-Defined Fields

In GroupWise 8, the following eDirectory fields have been added to the list of default fields that are 
available in the GroupWise Address Book:

Street Address
PO Box
City
State or Province
Zip Code
Locality/Mailstop
Mobile Phone
Pager Number
Home Phone
Other Phone
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When a domain is converted to GroupWise 8, if you have created any admin-defined fields that 
correspond to these new default fields, the values are transferred from the admin-defined fields to 
the new fields. In ConsoleOne, you can use Cleanup under Tools > System Operations > Admin-
Defined Fields to delete any admin-defined fields you have created that correspond to the new 
default fields.

6.1.2  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot use 
an IP address or DNS hostname.

6.1.3  Identity Manager Version Compatibility

Do not run a DirXML® or Identity Manager (IDM) driver earlier than version 3.5.2 against a 
GroupWise 8 system. Older drivers are not compatible. You can download the latest version of the 
GroupWise IDM driver from Novell Downloads (http://download.novell.com).

For more information, see TID 7002222: “How is the GroupWise 8 Driver Configured for Identity 
Manager?” in the Novell Support Knowledgebase (http://www.novell.com/support).

6.1.4  Identity Manager Configuration Issue

 The Identity Manager Accessory Portlet Reference Guide provides information for configuring 
GroupWise portlets. In particular, it instructs you to edit lines in the webacc.cfg file to appear as 
follows:

Security.UseClientIP.enable=false
Security.UseClientCookie.enable=false

It is preferable to make these changes in ConsoleOne, rather than in the webacc.cfg file. The Use 
client IP in security sessions setting and the Use Cookies settings default to selected (true) in 
ConsoleOne. If you do not deselect them in ConsoleOne, the “true” settings are written to the 
webacc.cfg file, overwriting your manual changes to that file. If this happens, the WebAccess 
client prompts for login multiple times.

1 In ConsoleOne, browse to and select the Domain object.
2 Right-click the GroupWiseWebAccess object, then click Properties.
3 Click Application > Security.
4 Deselect Use client IP in securing sessions.
5 Deselect the check boxes in the Use Cookies column.
6 Click OK.

6.1.5  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices, where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check the 
GroupWise Partner Products page (http://www.novell.com/partnerguide/section/468.html) for 
compatible products.
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6.2  NetWare/Windows Administration Issues
“ConsoleOne and Windows Support” on page 10
“eDirectory and Windows Support” on page 10
“GWTSA and Duplicate Source Directories” on page 10
“Quotas on NSS Volumes” on page 10
“eDirectory Admin User Surname on Windows” on page 10

6.2.1  ConsoleOne and Windows Support

ConsoleOne is not supported on Windows Vista or Windows Server 2008.

6.2.2  eDirectory and Windows Support

Versions of Novell eDirectory earlier than 8.8.4 are not supported on Windows Server 2008.

6.2.3  GWTSA and Duplicate Source Directories

The GroupWise Target Service Agent (GWTSA) handles situations where the same directory names 
are used for backups on different volumes by numbering the instances. For example:

Original GWTSA 

GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA 

GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:

Each instance is numbered and DOM is in all uppercase letters. After updating the GWTSA with 
GroupWise 6.5 Support Pack 1 or later, you must re-create your backup jobs because the path has 
changed.

6.2.4  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, you must turn on quotas on all GroupWise 
directories. Otherwise, you receive No Disk Space errors.

6.2.5  eDirectory Admin User Surname on Windows

When you create a new eDirectory tree on Windows, the surname of the Admin user is 
automatically set to a single space. This can cause problem in some GroupWise situations. For best 
results, manually set the surname of the Admin user to something meaningful.

6.3  Linux Administration Issues
“NFS Not Supported” on page 11
“Pathnames and Filenames in Lowercase” on page 11
“Unavailable Administration Features” on page 11
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6.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS*, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead if you must use Windows ConsoleOne to 
access a domain located on a Linux server.

6.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

6.3.3  Unavailable Administration Features

GroupWise 8 administration on Linux does not include the following features that are available in 
GroupWise 8 on NetWare and Windows:

Import/Export utility in ConsoleOne
Document Properties Management feature in ConsoleOne

7  Agent Issues
Section 7.1, “General Agent Issues,” on page 11
Section 7.2, “NetWare/Windows Agent Issues,” on page 12
Section 7.3, “Linux Agent Issues,” on page 12

7.1  General Agent Issues
“New View Files Now Overwrite Existing View Files” on page 11
“Evolution Compatibility with the POA and SOAP” on page 12
“Limitation of the /language Startup Switch” on page 12

7.1.1  New View Files Now Overwrite Existing View Files

When you update the POA software to GroupWise 8, updated view files are copied to the software 
distribution directory, but not to post offices. This maintains any customizations you might have 
made in the view files in post offices. 

However, when each GroupWise 8 POA starts for the first time, it copies the new view files from the 
software distribution directory to its post office. Therefore, if you have created custom view files 
with the same names as standard view files, you must create backup copies before starting the 
GroupWise 8 POA, so that your customized view files are not lost when the post office view files 
are updated. After you start the GroupWise 8 POA, restore your custom view files.

Occasionally, the POA is unable to copy the updated view files from the software distribution 
directory to its post office. When this happens, users receive a message that their view files are out 
of date. To resolve this, use the Refresh Views option under Tools > GroupWise Utilities > System 
Maintenance in ConsoleOne to update the post office view files from the software distribution 
directory. After you refresh the views, you must restore your customized view files to the post 
office.
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7.1.2  Evolution Compatibility with the POA and SOAP

Users might experience problems using EvolutionTM to connect to their GroupWise mailboxes if they 
are using Evolution 2.6.0 or earlier. In addition, earlier versions of Evolution can cause high 
utilization on GroupWise servers. To encourage users to update to the latest version of Evolution, 
you can use the /evocontrol switch in the POA startup file to configure the POA to allow only 
specified versions of Evolution. The /evocontrol switch takes either of the following parameters:

/evocontrol-"Evolution-1.10-yyyy-mm-dd"
/evocontrol-"Evolution-Data-Server-1.10-yyyy-mm-dd"

You can put up to 10 switch entries in the startup file, so you can list as many as 10 versions of 
Evolution. Entries beyond 10 are ignored. You can view the current entries at the POA Web console 
with the other SOAP settings. The POA log file lists the settings in the Soap Session section.

7.1.3  Limitation of the /language Startup Switch

If you use the /language startup switch to start the agents in a language that is different from the 
operating system, the list of agent settings does not display correctly.

7.2  NetWare/Windows Agent Issues
“NetWare POA Cannot Index PDF Files” on page 12

7.2.1  NetWare POA Cannot Index PDF Files

The third-party viewer application that converts PDF files to HTML for indexing is not working 
properly on NetWare. It successfully indexes PDF files on Linux and Windows.

7.3  Linux Agent Issues
“Non-root Agents on Open Enterprise Server for Linux Support Pack 2” on page 12
“Linux Agents Not Starting Automatically” on page 12
“Handling GroupWise Agent Core Files on Linux Servers” on page 13
“libXm.so.3 Error” on page 13

7.3.1  Non-root Agents on Open Enterprise Server for Linux Support Pack 2

On Novell Open Enterprise Server 2 and SUSE Linux Enterprise Server 10, services such as IMAP 
and IMAP SSL, which require port numbers below 1025, cannot be initiated or restarted after the 
GroupWise agents are running as a non-root user. To initiate or restart those services, you must 
manually stop the services and then restart the GroupWise agents.

7.3.2  Linux Agents Not Starting Automatically

Under certain circumstances, the Linux agents do not start automatically at system startup, even 
though you selected Launch GroupWise Agents on System Startup during installation. Use the 
following commands as root to correct the problem:

chkconfig grpwise off
chkconfig grpwise on
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7.3.3  Handling GroupWise Agent Core Files on Linux Servers

When the POA, the MTA, or the Internet Agent starts, it creates a file named process_id.pid in 
the same directory where log files for the agent are created. The process_id.pid file includes 
the build date of the agent that created the core file. When a GroupWise agent creates a core file, it is 
always named core.process_id. If you need to submit a core file to Novell Support, please 
include the corresponding process_id.pid file so that Novell Support can determine the 
specific agent build that created the core file. Old process_id.pid files can be manually deleted 
along with their corresponding core files.

To cause a GroupWise agent process to create a core file:

1 Edit the /etc/init.d/grpwise script in a text editor.
2 Uncomment the following line:

ulimit -c unlimited

3 Save the grpwise script, then exit the text editor.
4 Restart the agent.

The next time the agent crashes, the core file is created in the root directory of the server (/).
5 If the agent does not crash in a timely manner, use the following command as root to force a 

core file from the agent process:

kill -6 pid_number

where pid_number is the process ID number of the agent that is experiencing problems. Use 
the following command to obtain the PID number:

ps -eaf | grep agent_executable

where agent_executable is the name of a GroupWise agent (for example, gwpoa).
6 When you no longer need to collect core files, return to the grpwise script and comment out 

the ulimit line again, so that core files are no longer created.

7.3.4  libXm.so.3 Error

If you try to start the Linux POA or MTA by using the --show switch on a server where the X 
Window System* and Open Motif* are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.

8  Client Issues
Section 8.1, “Windows Client Issues,” on page 14
Section 8.2, “Linux/Mac Client Issues,” on page 16
Section 8.3, “Outlook Connector Issues,” on page 18
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8.1  Windows Client Issues
“GroupWise Version Compatibility for Panels” on page 14
“GroupWise Version Compatibility for Modified Recurring Calendar Items” on page 14
“Modify GroupWise Recipients Only” on page 14
“Default Contacts Folder” on page 15
“RSS Feed Format Limitation” on page 15
“OpenOffice.org Compatibility Issues” on page 15
“Archiving Over the Network” on page 15
“Novell Access Manager SSL VPN Compatibility Issue” on page 15
“Windows XP and Administrator Users” on page 16
“Address Books Do Not Display in GroupWise When Installing GroupWise after Outlook 
2003” on page 16
“Updated JAWS Script Available” on page 16
“VMware and Proxy” on page 16

8.1.1  GroupWise Version Compatibility for Panels

GroupWise 7 allows a maximum of two columns of panels. GroupWise 8 allows you to define 
additional columns of panels. If you define three or more columns of panels in GroupWise 8, then 
run an earlier GroupWise client, panels do not display correctly in the earlier GroupWise client and 
might need to be readjusted when you return to the GroupWise 8 client.

Displaying panels with varying monitor configurations, such as standard vs. wide-screen monitors 
and single vs. dual-monitor setups, can also result in altered panel display.

8.1.2  GroupWise Version Compatibility for Modified Recurring Calendar Items

In GroupWise 8, you can right-click a sent calendar item, then click Modify Recipients to add and 
remove GroupWise recipients without resending the calendar item. If the recipients include users on 
GroupWise 6.5 or GroupWise 7, those recipients see different functionality than GroupWise 8 
recipients.

GroupWise 6.5 post offices: The GroupWise 6.5 client still goes through the retract and 
resend process. Removed recipients see the retraction. Added recipients receive the new 
calendar item. Existing recipients in the post office must re-accept the calendar item.
GroupWise 7 post offices: Install the latest GroupWise 7 Support Pack POA. If you do not 
apply the latest Support Pack, GroupWise 7 users might see incorrect retractions and incorrect 
Reply to All lists. In addition, orphaned messages can accumulate in the GroupWise 7 post 
office. GroupWise 8 users might see incorrect totals for the number of delivered users.

8.1.3  Modify GroupWise Recipients Only

The new Modify Recipients feature works for recipients in your GroupWise system. It does not 
work for external Internet recipients.
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8.1.4  Default Contacts Folder

In GroupWise 8, the default Contacts folder is named Frequent Contacts and corresponds to your 
Frequent Contacts address book. Other personal address books display as subfolders under the 
Frequent Contacts folder.

In GroupWise 7, there was only one Contacts folder. It was assigned to your Frequent Contacts 
address book by default, but you could assign it to different personal address books. If you changed 
the address book assigned to the Contacts folder in GroupWise 7, this address book carries over as 
the main Contacts folder in GroupWise 8. 

If you want to change your main Contacts folder back to the Frequent Contacts address book:

1 Right-click your main Contacts folder, then click Properties.
2 In the Address Book field, select Frequent Contacts, then click OK.

8.1.5  RSS Feed Format Limitation

The GroupWise Windows client does not recognize RSS feeds that begin with:

feed://

Use the following format instead:

http://

8.1.6  OpenOffice.org Compatibility Issues

If you have configured GroupWise to use OpenOffice.org as your text editor, and if you click 
File > Send in OpenOffice.org, both GroupWise and OpenOffice.org hang. There is currently 
no workaround.
If you have configured GroupWise to use OpenOffice.org 3.0 as your text editor, and if you 
click the Spell Check button in a new item, the Spell Checker dialog box does not open. There 
is currently no workaround for Spell Checker. However, Quick Speller continues to work as 
usual.
If you have configured GroupWise to use OpenOffice.org as your text editor, a few specific 
editing actions might cause the GroupWise client to crash. Update to OpenOffice.org 2.4 to 
resolve the problem.

8.1.7  Archiving Over the Network

The recommended location for a Windows client user’s archive is on his or her local workstation. 
Creating an archive on a network drive is supported only if the Novell Map Network Drive feature 
of the Novell client is used to map a network drive from the user’s workstation to a NetWare server 
where the archive is located. Other configurations for archiving to network locations are not 
supported.

8.1.8  Novell Access Manager SSL VPN Compatibility Issue

If you want to run Novell Access Manager SSL VPN on the same Windows workstation with 
GroupWise 8, install SSL VPN, then install GroupWise 8. If any version of GroupWise is already 
installed on the workstation, uninstall GroupWise, install SSL VPN, then install GroupWise 8.
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8.1.9  Windows XP and Administrator Users

If GroupWise 7 has already been installed on a workstation by an administrator user, and if 
GroupWise 8 is installed by a different administrator user, a second instance of GroupWise is 
installed and the first instance is not updated. To fix this problem, go to the Control Panel, then 
double-click Add/Remove programs. If GroupWise is listed twice, remove the obsolete instance.

8.1.10  Address Books Do Not Display in GroupWise When Installing GroupWise 
after Outlook 2003

If you install Outlook*, then install GroupWise, then uninstall Outlook, you must reinstall 
GroupWise in order to restore MAPI, which is uninstalled along with Outlook. To avoid this 
problem, uninstall Outlook before installing GroupWise.

8.1.11  Updated JAWS Script Available

Users of the JAWS* screen reader should install the new JAWS script available in GroupWise 7 and 
8. Follow the instructions in the \client\jaws\gw_jaws_readme.txt file to install the 
JAWS script and other files on your workstation. This JAWS script includes Section 508 
accessibility bug fixes that have occurred since the script was updated for GroupWise 6.5 Support 
Pack 3.

8.1.12  VMware and Proxy

If you run the GroupWise Windows client in a VMware* virtual machine, you might receive an 
8503 error when you try to proxy to another user’s mailbox or display a Multi-User Calendar. To 
eliminate this problem, you need to disable the VMware adapters on your Windows workstation.

1 Right-click My Network Places, then click Properties.
In the list of LAN connections, you see one or more VMware adapters.

2 Right-click each adapter, then click Disable.

8.2  Linux/Mac Client Issues
“Pop-Up Display Problems with XGL” on page 17
“Dependency Issue on openSUSE” on page 17
“Problem Displaying Flash Content in Web Panels” on page 17
“KDE Integration with the Linux Client” on page 17
“Indexing Limitation of Mac Client in Caching Mode” on page 17
“Default Contacts Folder” on page 17
“Running as root in Caching Mode” on page 18
“Mailbox Size Limits Not Recognized” on page 18
“Archiving Over the Network” on page 18
“No Progress Bar Displayed When a Database Is Rebuilt” on page 18
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8.2.1  Pop-Up Display Problems with XGL

If you run the Linux client on SUSE Linux Enterprise Desktop (SLED) with XGL enabled to 
facilitate 3D rendering and desktop acceleration, some GroupWise pop-ups (such as for logging in 
and searching) are blank. To resolve the problem immediately, turn off XGL. The permanent 
solution is a fix in SLED XGL processing, which is not yet available.

8.2.2  Dependency Issue on openSUSE

If you install the Linux client on openSUSE®, you might encounter a dependency issue. You can 
still install the Linux client RPM by using the --nodeps option to sidestep the dependency issue. The 
Linux client then runs successfully on openSUSE.

8.2.3  Problem Displaying Flash Content in Web Panels

In the GroupWise Linux client, if you display a Web page that includes Flash* content, and if you 
have Adobe* Flash Player 9 installed in your Web browser, the GroupWise Linux client might crash. 
Install the latest Support Pack for SUSE Linux Enterprise Desktop to resolve the problem. This 
Support Pack includes an updated version of Flash Player 9, where the problem no longer occurs.

8.2.4  KDE Integration with the Linux Client

By default, KDE applications like Konqueror or other KDE-based applications do not launch the 
Linux GroupWise client when a mailto link is selected. To configure KDE-based applications to 
work with the GroupWise Linux client, see TID 7001213 in the Novell Support Knowledgebase 
(http://www.novell.com/support).

8.2.5  Indexing Limitation of Mac Client in Caching Mode

The new indexable file types of PDF, OpenOffice.org, and Microsoft Office 2007 are not indexed by 
the Mac client in Caching Mode. The module that provides this functionality is not currently 
available on the Mac. If you change to Online mode, the POA handles this indexing, so you can find 
these document types in Online mode.

8.2.6  Default Contacts Folder

In GroupWise 8, the default Contacts folder is named Frequent Contacts and corresponds to your 
Frequent Contacts address book. Other personal address books display as subfolders under the 
Frequent Contacts folder.

In GroupWise 7, there was only one Contacts folder. It was assigned to your Frequent Contacts 
address book by default, but you could assign it to different personal address books. If you changed 
the address book assigned to the Contacts folder in GroupWise 7, this address book carries over as 
the main Contacts folder in GroupWise 8. 

If you want to change your main Contacts folder back to the Frequent Contacts address book:

1 Linux: Right-click your main Contacts folder.
Mac: Control-click your main Contacts folder.

2 Click Properties.
3 In the Address Book field, select Frequent Contacts, then click OK.
GroupWise 8 17
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8.2.7  Running as root in Caching Mode

If you run the Linux/Mac client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If pending 
requests from the root session remain when you log in as a regular user, regular user requests are 
backed up behind the root requests, which cannot be processed while you are logged in as a 
regular user. To resolve any problems, run the client as root again so that all messages are 
synchronized, then run as a regular user thereafter to prevent further problems.

8.2.8  Mailbox Size Limits Not Recognized

The Linux/Mac client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

8.2.9  Archiving Over the Network

The required location for a Linux/Mac client user’s archive is on his or her local workstation. 
Creating an archive on a network drive is not currently supported.

8.2.10  No Progress Bar Displayed When a Database Is Rebuilt

When prompted to rebuild your database, there is no progress indicator displayed during the rebuild 
process.

8.3  Outlook Connector Issues
“Outlook Compatibility” on page 18

8.3.1  Outlook Compatibility

The GroupWise Connector for Microsoft Outlook is not included with GroupWise 8. If you already 
have the GroupWise 7 Outlook Connector, you can use it to access your GroupWise 8 mailbox. 

The GroupWise 7 Outlook Connector is not supported with Outlook 2007. If you run the Outlook 
Connector Setup program where Outlook 2007 is installed, you receive the following message:

A version of Outlook compatible with the GroupWise Connector cannot be found. 
Install Outlook and run this install again.

9  WebAccess Issues
Section 9.1, “General WebAccess Issues,” on page 18
Section 9.2, “NetWare/Windows WebAccess Issues,” on page 21
Section 9.3, “Linux WebAccess Issues,” on page 22

9.1  General WebAccess Issues
“GroupWise 8 WebAccess Compatibility with Earlier Versions of WebAccess” on page 19
“New Location for the WebAccess Application Configuration File” on page 19
“Blank Login Page” on page 19
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“Login Page Reappears after Successful Login” on page 20
““Login Is Not Current” Error” on page 20
“Recommendation for Tomcat Memory Allocation (Heap Size)” on page 20
“Preventing Web Server Directory Browsing” on page 20
“Updates to WebAccess Templates” on page 20
“Exclusive Bind Functionality” on page 21

9.1.1  GroupWise 8 WebAccess Compatibility with Earlier Versions of WebAccess

Before GroupWise 8, you could successfully run different versions of the WebAccess Agent and the 
WebAccess Application together. For example, you could install a new version of the WebAccess 
Application on your Web server while still running the previous version of the WebAccess Agent for 
the domain. 

Starting in GroupWise 8, the recommended update procedure is to update all the WebAccess Agents 
in your GroupWise system first, then update all the WebAccess Applications. Long-term use of the 
mixed-version configuration is not supported and can result in time zone problems. You must update 
both the WebAccess Agent and the WebAccess Application to the same version in order to ensure 
proper functioning of the GroupWise 8 WebAccess client.

IMPORTANT: Running a new WebAccess Application with an older WebAccess Agent is no 
longer supported.

9.1.2  New Location for the WebAccess Application Configuration File 

The location of the WebAccess Application configuration file (webacc.cfg) has changed in 
GroupWise 8.

If you have manually modified settings in your existing webacc.cfg file in the old location, you 
must make the same manual changes to the new webacc.cfg file in the new location. Differences 
between the old file and the new file are not merged into the new file by the GroupWise Installation 
program.

The WebPublisher Application configuration file (webpub.cfg) has also been moved to a parallel 
new location and customizations to the file must be transferred manually.

9.1.3  Blank Login Page

The GroupWise 8 WebAccess client Login page might flash and then go blank in Internet Explorer* 
7. If this happens, clear the browser cache. In Internet Explorer, click Tools > Delete Browsing 
History > Delete All.

Platform Old Location New Location

NetWare: sys:\novell\webaccess sys:\novell\groupwise\webaccess

Linux: /opt/novell/groupwise/webaccess /var/opt/novell/groupwise/webaccess

Windows: c:\novell\webaccess c:\novell\groupwise\webaccess
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9.1.4  Login Page Reappears after Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or the 
Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 Click Application > Security, then deselect Use Client IP in Securing Sessions. 
For information about this option, click Help on the Environment page.

3 Click OK to save the change.

9.1.5  “Login Is Not Current” Error

If you are already logged in to the WebAccess client and you try to log in again without logging out 
first, you receive the Login In Not Current error. This is working as designed for security 
reasons.

9.1.6  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is set 
by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

9.1.7  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the /
com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache, you can modify the httpd.conf file to remove the access that 
is provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

9.1.8  Updates to WebAccess Templates

If you have created your own customized version of any of the WebAccess template files, you must 
copy your customized versions to the following directory for your platform:

NetWare: sys:\\novell\groupwise\webaccess\templates\webacc\css 

Linux: /var/opt/novell/groupwise/webaccess/templates/webacc/css

Windows: \novell\groupwise\webaccess\templates\webacc\css
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In addition, if you have created your own customized versions of the WebAccess send.inc and 
msgitem.htt templates, you need to make the following changes to these files in order for them 
to be compatible with GroupWise 7 and 8:

Do not use the Url.Item.Reply.to and Url.Item.Reply.cc variables to pass and post names in a 
reply message’s To and CC fields. Instead, use Item.toFullID and Item.ccFullID (or 
Item.toName or Item.ccName).
When issuing an Item.Read action for a reply, set the Item.Reply parameter to either “sender” 
(to reply only to the sender) or “all” (to reply to all).

9.1.9  Exclusive Bind Functionality

On the Network Address property page of the WebAccess Agent object, ConsoleOne provides a 
Bind Exclusively to TCP/IP Address field, parallel to the other GroupWise agents. However, the 
WebAccess Agent does not currently read this setting from the domain database. Use the /ip startup 
switch instead to set an IP address for an exclusive bind for the WebAccess Agent.

9.2  NetWare/Windows WebAccess Issues
“WebAccess Service Fails to Start on Windows Servers” on page 21
“Novell iManager Compatibility on Windows” on page 21
“GroupWise 6.5 Upgrade on NetWare” on page 21
“Problem Downloading Large Attachments” on page 22
“Memory Problem” on page 22
“Viewer Agent Issues on NetWare” on page 22

9.2.1  WebAccess Service Fails to Start on Windows Servers

If you install the WebAccess Agent as a Windows service, reboot the server, and then do a 
workstation login as an Administrator, the WebAccess Agent service might fail to start. If this 
occurs, update to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.2  Novell iManager Compatibility on Windows

Do not install WebAccess and Novell iManager on the same Windows 2000/2003 server. Because 
WebAccess installs and configures its own Tomcat and Jakarta connector, it must be installed on a 
server where Tomcat is not already in use by another program. If they are installed on the same 
server, either WebAccess or iManager does not work.

9.2.3  GroupWise 6.5 Upgrade on NetWare

If the GroupWise 6.5 WebAccess Application is running on the server where you plan to install 
GroupWise 8 WebAccess, you should manually stop WebAccess, the Web server, and Tomcat before 
starting the GroupWise 8 installation. Under certain circumstances, the GroupWise Installation 
program cannot stop them for you.
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9.2.4  Problem Downloading Large Attachments

On NetWare 6.5 Support Pack 5, you might need to install a Winsock patch that enables users to 
download large attachments when they are using SSL connections to WebAccess. For a workaround, 
see TID 10100680 in the Novell Support Knowledgebase (http://www.novell.com/support).

9.2.5  Memory Problem

On NetWare 6.5 Support Pack 5, you might receive one of the following error messages on the 
server where the WebAccess Agent is running:

Server logical address space is running low ...
Short term memory allocator is out of memory ...
Cache memory allocator out of available memory ...

A patch for this problem is available in TID 2973639 in the Novell Support Knowledgebase (http://
www.novell.com/support).

9.2.6  Viewer Agent Issues on NetWare

On NetWare, the Viewer Agent requires at least 1 GB of memory for running about 5 worker 
threads. By default, 5 threads are started. The maximum number of threads has been lowered to 
8.
On NetWare, Memory Protection Fault Cleanup must be set to On in order for the Viewer 
Agent worker processes to recover successfully when a document fails HTML conversion.
On NetWare, Memory Protection Restart Count should be set greater than 1.
On NetWare, when a document fails HTML conversion and its worker process dies, NetWare 
creates a small file named core*.dmp in the server’s root directory. You should periodically 
delete these files.

9.3  Linux WebAccess Issues
“WebAccess Installation Security” on page 22
“WebAccess Update Issue” on page 23
“Conflict with GroupWise 7 Version of the WebAccess Application” on page 23
“WebAccess Re-installation Issue” on page 23
“Viewer Agent Issues on Linux” on page 23

9.3.1  WebAccess Installation Security

During installation, the Linux WebAccess Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server’s trusted root certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the WebAccess.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.
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9.3.2  WebAccess Update Issue

If you update an existing WebAccess installation to GroupWise 8, you must use both the Install and 
Configure options in the GroupWise Installation program in order for the GroupWise 8 version of 
WebAccess Application to be installed and configured correctly. If you do not run the Configure 
option, you continue to run old WebAccess Application, not the GroupWise 8 version.

9.3.3  Conflict with GroupWise 7 Version of the WebAccess Application

If you are updating from GroupWise 7, and if you have been using the Novell versions of Apache 
and Tomcat that were included with an early version of GroupWise 7, you might encounter 
problems displaying the GroupWise 8 WebAccess client Login page. To resolve the problem, see 
TID 7001268 in the Novell Support Knowledgebase (http://www.novell.com/support).

9.3.4  WebAccess Re-installation Issue

If you install Linux WebAccess in an eDirectory context where the WebAccess objects already exist, 
a message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must customize 
the objects again after installing WebAccess on Linux. 

9.3.5  Viewer Agent Issues on Linux

On Linux, if you run the Viewer Agent as a user that is not running the X Window system, 
WebAccess client users cannot view embedded vector-based graphics in attachments. To 
enable users to view embedded vector-based graphics, make sure that the user that starts 
WebAccess (and hence, the Viewer Agent) is running the X Window System and has a 
DISPLAY environment variable set so that the Viewer Agent can write to the local display. One 
way to accomplish this is to use the sux command to become root before you start the 
WebAccess Agent.
On Linux, the third-party viewer software used by the Viewer Agent has a dependency on 
libXm.so.1, which might not be included with your Linux package. To resolve this, create a 
symbolic link in the agents lib directory to the version of the libXm modules that is available 
on your Linux server. For example:

ln -s /usr/X11R6/lib/libXm.so.3.0.1 /opt/novell/groupwise/
                                               agents/lib/libXm.so.1

10  Internet Agent Issues
Section 10.1, “General Internet Agent Issues,” on page 24
Section 10.2, “NetWare/Windows Internet Agent Issues,” on page 24
Section 10.3, “Linux Internet Agent Issues,” on page 24

10.1  General Internet Agent Issues
“GWAVA Compatibility” on page 24
“Address Resolution Change Since GroupWise 6” on page 24
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10.1.1  GWAVA Compatibility

The XML tags used by the GroupWise 8 Internet Agent are incompatible with what existing 
GWAVA software is expecting. To resolve the problem, download updated GWAVA software from 
the following URL:

http://download.gwava.com/gwava4/gwvgwia_gw8.zip

10.1.2  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for sending 
to distribution lists and resources if you set Internet Addressing to one of the following formats 
(which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain
last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the Internet 
Agent. The Internet Agent then successfully resolved the addresses and sent the messages back into 
the GroupWise system. Users did not notice the problem, but some administrators noticed 
unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If you are updating from 
GroupWise 6 to GroupWise 8 and unnecessary traffic through the Internet Agent is a continuing 
problem, have users delete distribution lists and resources from their Frequent Contacts address 
books so that the correct address format is used for name completion in the future.

10.2  NetWare/Windows Internet Agent Issues
None.

10.3  Linux Internet Agent Issues
“Internet Agent Installation Security” on page 24
“libXm.so.3 Error” on page 25

10.3.1  Internet Agent Installation Security

During installation, the Linux Internet Agent Installation program requires access to eDirectory by 
way of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s trusted root certificate, which must be exported from the LDAP server, 
in order for LDAP authentication to take place (typically on port 636) during installation of the 
Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of the Internet Agent. After disabling the option, restart 
eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with Password 
and restart eDirectory again.
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10.3.2  libXm.so.3 Error

If you try to start the Linux Internet Agent by using the --show switch on a server where The X 
Window System and Open Motif are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

11  Calendar Publishing Host Issues
Section 11.1, “General Calendar Publishing Host Issues,” on page 25
Section 11.2, “NetWare/Windows Calendar Publishing Host Issues,” on page 25
Section 11.3, “Linux Calendar Publishing Host Issues,” on page 26

11.1  General Calendar Publishing Host Issues
“Attachments Not Published” on page 25
“Compatibility Issue with Novell Access Manager” on page 25

11.1.1  Attachments Not Published

If calendar items include attachments, the attachments are not published to the Web along with the 
published calendar items.

11.1.2  Compatibility Issue with Novell Access Manager

You cannot access a published GroupWise calendar through an Access Manager proxy server. The 
authentication required by Access Manager causes access to the Calendar Publishing Host to fail.

11.2  NetWare/Windows Calendar Publishing Host Issues
“Calendar Publishing Host Application Not Installed Correctly” on page 25

11.2.1  Calendar Publishing Host Application Not Installed Correctly

Because the Calendar Publishing Host Application is not installed correctly on Windows, you 
receive a Page Not Found error when you try to view the calendar browse list at:

http://server_address/gwcal

As a temporary workaround, specify port 8080:

http://server_address:8080/gwcal

As a permanent workaround:

1 On your Web server, change to the following directory:

 c:\novell\GroupWise\connector\conf
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2 Open the uriworkermap.properties file in a text editor.
3 Add the following lines:

/gwcal/*=ajp13w
/gwcal=ajp13w

4 Save the file, then exit the editor.
5 Restart IIS and Tomcat to put the changes into effect.

11.3  Linux Calendar Publishing Host Issues
None.

12  Monitor Issues
Section 12.1, “General Monitor Issues,” on page 26
Section 12.2, “Windows Monitor Issues,” on page 27
Section 12.3, “Linux Monitor Issues,” on page 27

12.1  General Monitor Issues
“New Location for the Monitor Application Configuration File” on page 26
“Restoring Monitor Settings after Reinstallation” on page 27
“Monitor Agent SSL Configuration” on page 27

12.1.1  New Location for the Monitor Application Configuration File 

The location of the Monitor Application configuration file (gwmonitor.cfg) has changed in 
GroupWise 8.

If you have manually modified settings in your existing gwmonitor.cfg file in the old location, 
you must make the same manual changes to the new gwmonitor.cfg file in the new location. 
Differences between the old file and the new file are not merged into the new file by the GroupWise 
Installation program.

12.1.2  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. Agent 
groups are also stored in this file. If you reinstall the Monitor software, the monitor.xml file is 
backed up as monitor.001. To restore previous Monitor settings and agent groups, remove the 
newly installed monitor.xml file and rename monitor.001 to monitor.xml.

Platform Old Location New Location

NetWare: sys:\novell\gwmonitor sys:\novell\groupwise\gwmonitor

Linux: /opt/novell/groupwise/gwmonitor /var/opt/novell/groupwise/monitor

Windows: c:\novell\gwmonitor c:\novell\groupwise\gwmonitor
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12.1.3  Monitor Agent SSL Configuration

If you want to enable SSL by using the Monitor Agent /httpssl and /httpcertfile switches, the 
certificate file must be in PEM format. This differs from the other GroupWise agents, which take a 
.b64 public certificate file and a .key private key file. The PEM format combines the certificate 
and key in a single file.

12.2  Windows Monitor Issues
None.

12.3  Linux Monitor Issues
“Monitor Issues Shared with WebAccess” on page 27

12.3.1  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues also pertain to Monitor:

Section 9.3.1, “WebAccess Installation Security,” on page 22
Section 9.3.2, “WebAccess Update Issue,” on page 23
Section 9.3.4, “WebAccess Re-installation Issue,” on page 23

13  International Issues
Section 13.1, “General International Issues,” on page 27
Section 13.2, “NetWare/Windows International Issues,” on page 30
Section 13.3, “Linux International Issues,” on page 30

13.1  General International Issues
“Different Language Codes for Some Languages” on page 27
“Asian Address Book Issue” on page 28
“Default MIME Encoding Change” on page 28
“Double-Byte Character Restrictions” on page 29
“WebAccess Attachments with Extended Characters in Filenames” on page 29

13.1.1  Different Language Codes for Some Languages

Starting with GroupWise 8, some language codes have changed from their previous values to ISO-
standard values.

Language Old Code New Code

Danish DK DA

English US EN
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13.1.2  Asian Address Book Issue

Starting with GroupWise 8, Unicode* characters are used in the GroupWise Address Book and in 
personal address books. When the GroupWise 8 POA first runs for a post office, it converts the 
GroupWise Address Book to the current standard. When the GroupWise 8 Windows client first 
accesses a user’s mailbox, it converts all personal address books to the current standard. When you 
update a POA to GroupWise 8, users with Asian characters in their personal address books must 
update to the GroupWise 8 Windows client as well.

NOTE: The GroupWise Linux/Mac client has always used Unicode characters, so Linux/Mac client 
users do not need to update immediately.

If you use a pre-GroupWise 8 Windows client to access a GroupWise 8 post office, address book 
entries display correctly, but name completion and searching do not work. If a user users a pre-
GroupWise 8 Windows client to add entries to a personal address book, name completion and 
searching do not work for these entries when that user updates to GroupWise 8. The Contents Check 
feature of GroupWise Check has been enhanced to repair problems with personal address books that 
might be introduced by running an older Windows client after a post office has been updated to 
GroupWise 8.

13.1.3  Default MIME Encoding Change

After GroupWise 7 Support Pack 1, the GroupWise client started using UTF-8 instead of ISO for 
MIME encoding. This causes occasional problems in some languages where GroupWise 6.5 clients 
are being run against GroupWise 7 or 8 post offices. To help with the transition, a Support option has 
been added to GroupWise Check (GWCheck) to convert user databases back to the ISO encoding 
for your language.

1 Start GWCheck as described in GroupWise Check in Databases in the GroupWise 8 
Administration Guide on the GroupWise 8 Documentation Web site (http://www.novell.com/
documentation/gw8).

2 Under Database Type, select Post Office.
3 In the Database Path field, browse to and select the post office directory.
4 Under Object Type, select User/Resource.

If you want to perform the conversion on all user and resource databases in the post office, 
specify ALL in the User/Resource field.

5 In the Action drop-down list, select Reset Client Options.
6 In the Support Options field on the Misc tab, type setmimeencoding=number, where 

number is one of the following character set numbers:

Finnish SU FI

Hungarian MA HU

Japanese JP JA

Korean KR KO

Portuguese BR PT

Language Old Code New Code
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7 Click Run to perform the conversion of user and resource databases from UTF-8 to the selected 
character set.

13.1.4  Double-Byte Character Restrictions

Do not use double-byte characters in directory names and filenames.
Do not use double-byte characters in user passwords. The Change GroupWise Password dialog 
box in ConsoleOne currently allows entry of double-byte characters. However, the GroupWise 
client login does not allow entry of double-byte characters in passwords, so a user who was 
assigned a password with double-byte characters in ConsoleOne cannot type the double-byte 
characters when attempting to log in to GroupWise. 

13.1.5  WebAccess Attachments with Extended Characters in Filenames

On Windows, Mozilla*-based browsers such as Firefox* and Netscape* do not save extended 
character filenames correctly, even though the filename displays correctly in the Save As dialog box. 
This is a browser problem, not a GroupWise problem. There is no workaround.

In Safari* on Macintosh, extended character filenames are not interpreted correctly. As a 
workaround, use Firefox instead of Safari if you receive attachments with extended character 
filenames. This is a browser problem, not a GroupWise problem. 

Character 
Set Number Language

1 Windows default

2 ISO default

7 Arabic (Windows 1256)

9 Baltic (Windows 1257)

12 Central European (Windows 1250)

13 Chinese Simplified (GB2312)

15 Chinese Traditional (Big5)

18 Cyrillic (K018-R)

27 Hebrew (Windows 1255)

29 Japanese (ISO2022-JP)

30 Japanese (Shift-JIS)

32 Korean (EUC-KR)

33 Thai (Windows 874)

35 Turkish (Windows 1254)

3 UTF-8
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13.2  NetWare/Windows International Issues
“Print Calendar Language” on page 30
“GWCSRGEN Utility Doesn’t Start in Spanish” on page 30

13.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

13.2.2  GWCSRGEN Utility Doesn’t Start in Spanish

On a Windows server running the Spanish version of Windows, the GWCSRGEN utility does not 
start successfully. Use the English version of GWCSRGEN instead. GWCSRGEN runs successfully 
on other language versions of Windows.

13.3  Linux International Issues
“Display Problem with Agent Console Interfaces” on page 30
“Russian Keyboard” on page 30
“Mnemonics for Arabic, Hebrew, and Double-Byte Languages” on page 31
“Localized Agent User Interface Display” on page 31

13.3.1  Display Problem with Agent Console Interfaces

If you run the Linux GroupWise agents with an agent console interface in languages other than 
English, the logging information might not display correctly. The problem occurs if your language 
encoding is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:

locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.
2 Select the language you are running the agents in, then click Details.
3 Deselect Use UTF-8 Encoding, then click OK.
4 Stop and then restart the agents to put the new setting into effect.

13.3.2  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are usually set to ru_RU. Typically, this setting implies the Russian character set 
ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be set 
explicitly in order for your Russian keyboard to work with the GroupWise Linux/Mac client. Use 
the following command to specify the character set along with the language and locale information:

export LANG=ru_RU.ISO-8859-5
Wise 8
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In most cases, setting the LANG environment variable also sets all LC_* environment variables and 
resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

13.3.3  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

13.3.4  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

If the Linux environment is using a different character set encoding, such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

14  Documentation Issues
Section 14.1, “General Documentation Issues,” on page 31
Section 14.2, “NetWare/Windows Documentation Issues,” on page 31
Section 14.3, “Linux Documentation Issues,” on page 32

14.1  General Documentation Issues
None.

14.2  NetWare/Windows Documentation Issues
“GroupWise Windows Client Help” on page 31

14.2.1  GroupWise Windows Client Help

To support accessibility requirements within GroupWise Help, the Help for the GroupWise 
Windows client uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.

Language Character Set Code

French fr_FR

German de_DE

Portuguese pt_BR

Spanish es_ES
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14.3  Linux Documentation Issues
“Agent Help Does Not Display When the Agent Runs as a Non-root User” on page 32
“Help Image Display on a Novell Access Manager Server” on page 32

14.3.1  Agent Help Does Not Display When the Agent Runs as a Non-root User

When you start the Linux POA, the Linux MTA, and the Linux Internet Agent by using the --show 
switch to display a GUI user interface, if the agents are running as a non-root user, clicking Help 
does not display the agent help file. Help is displayed in a browser window and the agents currently 
launch the browser as root. Giving the user access to the browser window as root would be a 
security risk. This is working as designed.

14.3.2  Help Image Display on a Novell Access Manager Server

If you display help from an agent Web console on a server where Novell Access Manager is 
installed, and if Access Manager is configured to use the Path-Based Multihoming option, the image 
at the top of the help topic does not display.

15  Documentation
All GroupWise 8 documentation is available at the GroupWise 8 Documentation Web site (http://
www.novell.com/documentation/gw8):

Full GroupWise product Readme
Quick Start
Installation Guide
Administration Guide
Multi-System Administration Guide
Interoperability Guide
Troubleshooting Guides
GroupWise Client User Guides
GroupWise Client FAQ

NOTE: As GroupWise 8 Support Packs are released, Support Pack Readmes are placed on the 
GroupWise 8 Documentation Web site.

In addition to the GroupWise product documentation, the following resources provide additional 
information about GroupWise 8:

Novell Support and Knowledgebase (http://www.novell.com/support) 
GroupWise 8 Support Forums (http://forums.novell.com/novell-product-support-forums/
groupwise) 
GroupWise Cool Solutions (http://www.novell.com/communities/coolsolutions/gwmag) 
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16  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark.

17  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion 
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not 
use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please 
refer to the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for 
more information on exporting Novell software. Novell assumes no responsibility for your failure to 
obtain any necessary export approvals.

Copyright © 2008 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.

Novell, Inc. has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights 
may include one or more of the U.S. patents listed on the Novell Legal Patents Web page (http://
www.novell.com/company/legal/patents/) and one or more additional patents or pending patent 
applications in the U.S. and in other countries.

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).

All third-party trademarks are the property of their respective owners.
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